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Chapter 1
Introduction

What’s In This
Chapter?

Welcome

Who Needs
Desktop Poet?

Hardware and
Software
Requirements

Online Help

Notes

Welcome

Desktop Poet is "fridge poetry" for the desktop of your computer.

Desktop Poet presents you with hundreds of word tiles on your desktop, and by forming the
words into sentences or phrases, gives you the ability to compose imaginative prose or to
formulate specific brainstorming ideas.

Make your own word lists with any topic (Desktop Poet comes with word lists for sports,
classic movie stars, celebrities, scientific terms, and other such things). Export your poems
and ideas as a JPEG, BMP or HTML and send them to your family, friends, and colleagues.

Desktop Poet can display a dozen different background images, courtesy of
The3dStudio.com; or supply your own. Everything else is configurable too: the font, the
layout, colors, tile styles...everything.

Easily create poems or expand on your free flowing thought process, Desktop Poet visually
helps the poet or brainstormer in you with clearer thinking, more imaginative projects, and
better organized writing.
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Who Needs
Desktop Poet?

Who needs Desktop Poet?

•Poets
•Writers
•Playwrights
•Screenwriters
•Authors
•Educators
•Students
•Brainstormers
•Doodlers
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Hardware and
Software
Requirements

Technical
Support

Hardware and Software Requirements

To use Desktop Poet you need:

• Two MB (megabytes) of memory (RAM), 4 MB free hard disk space
• Windows Vista (32-bit or 64-bit) or Windows 7 (32-bit or 64-bit)

Technical Support

If you have a question about using Desktop Poet, try finding the answers you need in this
document or in the Desktop Poet online help. Alternatively, try the FAQ (Frequently Asked
Questions) page on our web site. View it at: http://www.marinersoftware.com/support/.

If you still can’t find the information you need, contact Mariner Software by phone, fax, or
email.
Email: support@marinersoftware.com

Mail: Mariner Software, Inc.
401 N. 3rd Street #570
Minneapolis, MN 55401
USA

For updates, tips and tricks, information about other Mariner products, user group discount
information, and articles for user group newsletter publication, visit our World Wide Web site
at: http://www.marinersoftware.com
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Online Help

Notes

Online Help

Desktop Poet supports Hot Help in Windows and is PDF-based. It can be found under the
Help menu in Desktop Poet titled Desktop Poet Help.

Notes

Before using Desktop Poet, you should have a basic knowledge of Windows. You should
understand pointing, clicking, double-clicking, dragging, and how to choose menu
commands. You should also know how to operate dialog boxes, resize windows, and copy
and paste. If you aren’t familiar with these or other basic computer operations or
terminology, refer to the documentation included with your computer. 
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Chapter 2
Menu Bar Functions

What’s In This
Chapter?

Main Window

Menu Bar

File
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Edit

Format

Window
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Contextual

The Main Window and Menu Bar

Figure1 The Desktop Poet main window and Menu Bar

Figure 2 The Menu Bar
The Menu Bar contains five items, File, Tiles, Edit , Format, and Help.
The Menu bar items are also available by right-clicking on the Poet item in the Windows
Task Bar.

Figure 3 The Menu Bar from the Task Bar
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File Menu
File Menu

Figure 4 The File Menu

•Set Word List - Brings up a dialog that
shows only the word list files that Desktop
Poet recognizes and have been imported into
the application. Word lists are in the following
location

C:\Program Files\MarinerSoftware\Poet\Wordlist

•Merge Word List - A custom dialog box
appears showing the word list files Desktop
Poet recognizes. Selecting a word list from
this dialog merges that word list with the
active word list. Word lists are in the
following location

C:\Program Files\MarinerSoftware\Poet\Wordlist
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File Menu
File Menu

Figure 5 The File Menu

•Import Word List - A dialog appears in
which you can locate word lists on your hard
drive and import them into Desktop Poet.

•Export Word List - Allows you choose the
name of the file you are exporting, along with
the location of where you want to save the
file.

•Download Word Lists -Takes you to a web
page to download word lists.
See also "Import Word List", "Set Word List" and
"Merge Word List" commands. 

•Export Selection to JPEG - Saves your active
word list or selected tiles as a JPEG image file.

•Export Selection to Bitmap - Saves your
active word list or selected tiles as a BMP
image file.

•Export Selection to HTML - Saves your
active word list or selected word tiles as a
HTML. HTML files can be used as Web Pages.

•Export Selection to Screen Saver - Saves
the current selection as an image to use for
the screen Saver.
See Using the Screen Saver on pages 27-28
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Tiles Menu
Tiles Menu

Figure 6 The Tiles Menu

•New Word Tile - Create a new word tile to
add to the active word list.

•New Image Tile - Choose an image from
your hard drive to add to the
active word list.

•Shuffle Tiles - Shuffles the tiles on your
desktop or virtual fridge.

•Resnap Selected Tiles - “Snaps” the
selected tiles into a group.
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Edit Menu
Edit Menu

Fig. 7 The Edit Menu

•Cut - Removes the selected tile or text and
places it on the Windows clipboard.

•Copy - Copies the selected tile or text and
places it on the Windows clipboard.

•Copy Image - Copies an image tile and
places it on the Windows clipboard.

•Paste - Pastes the tile or text contents of
the Windows clipboard.

•Delete - Deletes a tile from the active word
list.

•Duplicate - Duplicates a word tile from an
active word list.

•Select All - Selects all the word tiles in an
active word list. 

•Invert Selection - Inverts the previous
selection in an active word list.

•Deselect All - Deselects all the word tiles in
an active word list.

•Blink Selection - Blinks the selected word
tile(s) for easier viewing.
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Edit Menu

Fig. 8 Edit Menu

•Find - Searches text in the active word list.
The Find panel will preform a
prefix match.

•Find Exact - Searches for exact text in the
active word list.

•Define Tiles - Links you to dictionary.com
and shows the highlighted word(s) definition.

•Match Tiles - Matches and highlights
duplicate word tiles in the active word list.

•Preferences - This functions allows the
user to personally customize their copy of
Desktop Poet. Default Tile Settings, Drag
Snapping, and Virtual Fridge are the
categories of preferences available for
customizing. See Preferences
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Format Menu
Format Menu

Fig. 9 Format Menu

Fig 10 The Format Color submenu

•Color - Sets the color of selected word
tile(s).

•Style - Sets the visual style of selected word
tile(s). Choose from five different visual styles
(None, Raised, Flat, Boxed, or Lowered).

Figure 11 The Style submenu

•Font - Opens a dialog where you set the
font, style and size of selected word tile(s).
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•Color - Sets the color of selected word
tile(s).
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•Font - Opens a dialog where you set the
font, style and size of selected word tile(s).
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Help Menu
Help Menu

Fig. 12 Help Menu

•Registration - Allows the user to either
Register (purchase) Desktop Poet or run as a
full-functioning trial copy for a limited
amount of days.

•Desktop Poet Help - Launches the Desktop
Poet online manual in PDF format.

•Read Me - Opens the release notes for
Desktop Poet.

•Mariner Home Page - Links you back to the
Mariner Software web site.

•User Poetry Forum - The function links the
user to the User Poetry Forum page on the
Mariner Software web site where customers
can contribute their own poetry for posting.
Direct all requests for submissions to
press@marinersoftware.com.

•About Desktop Poet - Shows Desktop
Poet’s about box.
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Contextual
Menu

Contextual Menu

Fig. 13 Contextual Menu

•Word Forms - Choose from this list to set
the current word form for the selected tile.

•Add new definition - Opens a dialog where
you can add a new word form to the selected
tile.

•Tile Color - Sets the color of selected word
tile(s).

•Tile Style - Sets the visual style of selected
word tile(s). Choose from five different visual
styles (None, Raised, Flat, Boxed, or Lowered).

•Font - Opens a dialog where you set the
font, style and size of selected word tile(s).

•Define tiles - Links you to dictionary.com
and shows the highlighted word(s) definition.

•Delete tiles - Deletes the selected tile(s)
from the active word list.

•Duplicate tiles - Duplicates the selected
tile(s) from an active word list.

•Match Tiles - Matches and highlights
duplicate word tiles from the selection.
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Chapter 3
Tiles

What’s In This
Chapter?

This chapter
details how to
use and
customize the
word & image
tiles.

Multiple word
forms on each
tile.

Adding a word
form?

Where are the tiles like "ed", "ing" and "an"?
This is the chief difference between Desktop Poet and the poetry game you may have on your
refrigerator. Desktop Poet takes advantage of the fact that it is on a computer to both
increase the available vocabulary and decrease the number of tiles. It does this by allowing a
single tile to have more than one word on it. The words on a tile should all be related to each
other, such that it makes sense to place them together. For example, "run", "runs", "running",
"ran" and "runner" are on a single tile. This means that the "ending" tiles like "ed" and "ing" are
not needed in Desktop Poet; just choose the word form you want.

How do I choose the different forms of word tiles?
This is as easy as a right-click on the tile. At the top of the menu shown, before the other
contextual menu commands, will be the various word forms that exist for that tile. Choose
the form you want, and the tile will change. You can also rotate through word forms by
selecting a tile and pressing the "escape" key. Sometimes the tiles will be related
semantically, not syntactically; one tile might have the names of the twelve months of the
year, for example. Until you get familiar with the tile’s layout, the easiest way to locate a word
is to select “Find” and enter the applicable word. Find "runner", for example, and the "run" tile
will be selected. You can also use Desktop Poet's type-select feature by typing "is" (for
example); the "be" tile will be selected.

How do I add a word form to a tile?
Right-click on a tile and select “Add new definition” from the contextual menu. A dialog
appears where you can type a new word form. Press OK to dismiss the dialog and set the tile
to the new word form.
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Tiles

Selecting
multiple tiles?
Double-
clicking on
tiles

Drag selecting
tiles

Typing to find
a tile

Using the find
panel

What are the different ways to select tiles?
Desktop Poet's selection works much like selecting icons on the desktop; you can use the
mouse (with modifier keys if desired), you can type a word to select tiles with that word, or
you can use the Find panel to search for the tile you want to select. To select a tile, just click
on the tile you want to select. You can hold down the shift key to select additional tiles you
click on; hold down the control key to toggle a clicked tile between being selected and
deselected.

Dragging a selection rectangle in the virtual fridge works just as it does in Windows, holding
the control key will add more tiles to your previous selection.

To select by typing, just start typing, whatever you type is matched against the contents of
the tiles (both the visible word form, and any alternate word forms on the tiles). If there are
tiles that match exactly (you type "run" and the tile has "run"), all tiles with exact matches
will be selected. If there are no exact matches, then it will match prefixes (you type "ze" and
the tiles has "zebra").

Selection with the Find panel is exactly as you would expect; select the Find menu item, type
some text, hit OK, and the tiles that match are selected. The Find panel does a prefix match;
if you want an exact match, choose Find Exact instead.
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Chapter 4
Word Lists

What’s In This
Chapter?

How to edit,
add, and
create word
lists

Making word
lists.

Example word
List

Word list tags

What is a word list?
Word lists are the words you see on the tiles. Some word lists are small and are designed to
be merged into a larger, general vocabulary to provide special-interest terms related to things
like sports or science. Other word lists are large and are designed to be used as a base
vocabulary.

Where can I get more?
You can download word lists, email them to family and friends, or post them on your web
page. Within Desktop Poet, you can: replace your current set of tiles with new tiles based on a
word list of your choice, or you can merge in a word list, creating new tiles for the words in
the word list while keeping your current tile set. Create word lists in Desktop Poet by
exporting the set of words you are currently using. You can create or modify word lists in a
word processor. See Making your own word lists later in this chapter for more information.

Tracking word lists
Choosing "Set Word List" or "Merge Word List" menu items makes a dialog appear showing
word list files that Desktop Poet recognizes. Import Word lists (lists you download, receive in
email, etc.;) using the  "Import Word List" menu command (double-clicking the word list file
works too). This copies the word list to C:\Program Files\MarinerSoftware\Poet\Wordlist. Desktop
Poet doesn't show the word list file names when you set or merge them; it presents you with a
more readable title and the number of words in the list. Desktop Poet shows you content like
the language of the word list, a longer explanation of the contents, and other information.
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Word Lists

Making your
own word
lists.

Example Word
List

Making your own word lists?
Making your own word lists is simple. All you need is a word processor that works with plain
text files (Mariner Write works well). Suggestion: You might want to work from an existing
word list, so you automatically get the basic structure of the file.

A typical word list looks like this:

// This is a word list for Desktop Poet.
@title Music
@longtitle These are a few of my favorite people
@language English
@dictionary http://www.marinersoftware.com/php/search2.php3?f=artist&q=%@`=Go
@author Logan Ryan
@version 1
@copyright Copyright (C) 2012 Mariner Software
@words
“Irwin Fletcher” Fletcher
“Raymond Stantz” Stantz
“Mandy Pepperidge” Pepperidge
"Jeff Spicoli" Spicoli
"Debbie Thompson" Thompson
"Ted Logan" Logan
"Reggie Hammond" Hammond
"Tony D’Annunzio" D’Annunzio
"Chet Donnelly" Donnelly
@end

The "//" starts a comment at the top of the file, which similarly lasts until the end of the line.
You can put // comments anywhere you want (but only as a full line of content, not as the
end of a line with other content).
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Word Lists

Tags in Word
lists

@dictionary

@longtitle

@author

@language

@version

@copyright

Tags begin with an '@' symbol, they occur one per line, and the remainder of the line after the
tag is the value.

The @dictionary tag tells Desktop Poet where to look up words in this word list when asked
to define them; since these are all musicians, the URL is for a music site. "%@" near the end
of the URL is where the word to be defined gets plugged in, so if Desktop Poet is asked to
define "Jeff Spicoli", it generates this URL:
http://www.marinersoftware.com/php/search2.php3?f=artist&q=Jeff+Spicoli ‘=Go.

@longtitle, @author, and @language tags give information that Desktop Poet shows to help
you choose a word list.

The @version tag is not currently used, but will probably be used by a future version of
Desktop Poet to facilitate automatic updating of a user's word lists; it should start at 1 and
be incremented by one each time you publish a new revision of your word list.

The @copyright tag provides a standard place for a copyright notice; this text may be
displayed in future versions of Desktop Poet@author tag is the place to put your name
so you get the credit for creating the wordlist.

Between the @words tag and the @end tag are the words. Each tile is one line; multiple word
forms for a single tile are listed one after another on the same line. The line '"Chet Donnelly"
Donnelly' makes one tile with two word forms: "Chet Donnelly" and "Donnelly". The quotes
around "Chet Donnelly" indicate that the space is part of the "word", not a divider between
two different words.

A number i.e."2" at the end of a line makes two identical Chet Donnelly tiles. If a number is
absent, one tile is created. If you want to include a quote mark (") in a word, you need to
preface it with a backslash (\") so Desktop Poet doesn't take it as establishing a quoted
string. If you want to include a backslash, you need to quote it in the same manner (\\).
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Word Lists

Examples

Below are some examples of a word list. The column on the left is the string as it would be
written in the word list file; the column on the right is what the resulting tile will look like.

foo foo
"foo" foo
foo bar foo (bar is taken as the second word form)
"foo bar" foo bar
"foo \"bar\"" foo "bar"
foo\\bar foo\bar
foo\ bar foo bar (the backslash quotes the space as a literal character)
foo 2 foo (two tiles that each say foo)
foo "2" foo (2 is the second word form on the tile, since it was quoted)
foo2 foo2 (numbers are not taken as a count unless they are separate)
foo\ 2 foo 2 (the backslash quoted the space, continuing the word
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Chapter 5
Virtual Fridge

What’s In This
Chapter?

This chapter
details how to
use and
customize the
Virtual Fridge.

Setting
Preferences

Default Tile
Settings

Virtual Fridge
Settings

Screen Saver
Settings

What is the Virtual Fridge?

Desktop Poet keeps your tiles inside a containing environment called the virtual fridge.
One of the most customizable features of the virtual fridge is the various background
textures it can display below your tiles. These textures are generously provided by
www.The3dStudio.com; you can visit their website for many more free textures that you
can download. Put your downloaded texture images in C:\Program
Files\MarinerSoftware\Poet\Texture.. Desktop Poet adds the textures to the list available in
the Preferences panel, so you can use them in your virtual fridge.

Fig. 14 The Virtual Fridge
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Fig. 14 The Virtual Fridge
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Preferences

Default Tile
Settings

Figure 15 The Preferences

Hint: Be careful when using the Apply to all button
you will override any current tile settings on screen
with the new default settings.

Default Tile Settings

•Color - Sets the default color of new word
tiles.

•Style - Sets the default visual style of new
word tiles. Choose from five different
visual styles (None, Raised, Flat, Boxed, or
Lowered).

•Set Tile Font - Opens a dialog where you
set the default font, text color, style, and
size of new word tiles.

•Apply to all - Sets all the current tiles on
screen to the default settings.

•Virtual Fridge - Copies the selected tile
or text and places it on the Windows
clipboard.

•Screen Saver - Copies an image tile and
places it on the Windows clipboard.

•Drag Snapping - Pastes the tile or text
contents of the Windows clipboard.
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Preferences

Virtual Fridge
Settings

Figure 16 The Preferences

Hint: You can access the application menus by right-
clicking on the Desktop Poet item in your Task Bar.
This is especially important when using the Windows
Desktop option since you can’t see the application
window and menus.

Virtual Fridge

•White background - Sets the background
color of the virtual fridge to white.

•Colored background - Sets the
background color of the virtual fridge to a
color you select.

•Textured image - Sets the background
of the virtual fridge to a texture image.

•Tiled Textured images can be ‘tiled’
so that a smaller image is repeated to
fill the screen as a solid pattern.

•Photograph - Sets the background of the
virtual fridge to a photograph or image of
your choice.

•Windows Desktop - Removes the
background of the virtual fridge. allowing
you to see through to the windows
Desktop

•Use Desktop Image Displays the
windows Desktop Image as the
background of the virtual fridge.
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Preferences

Screen Saver
Settings

Figure 17 The Preferences

Screen Saver

•Enabled - Turns on the windows screen
saver in Windows and sets it to use the
images.

•Configure - Opens the Windows Display
Properties control panel to the Screen Saver
tab.

Note: The Screen Saver works in conjunction
with the Export Selection to Screen Saver
loacted in the File menu. For more information
see the File Menu on Page 10
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Figure 17 The Preferences

Screen Saver

•Enabled - Turns on the windows screen
saver in Windows and sets it to use the
images.

•Configure - Opens the Windows Display
Properties control panel to the Screen Saver
tab.

Note: The Screen Saver works in conjunction
with the Export Selection to Screen Saver
loacted in the File menu. For more information
see the File Menu on Page 10
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Preferences

Screen Saver
Settings

Figure 18 The Windows Screen Saver

Screen Saver (Continued)

•Wait - Sets the amount of time before the
screen saver starts.

•Configure - Opens the Windows Display
Properties control panel to the Screen Saver
tab.

From the Windows Screen Saver, click
Settings.

Figure 19 Desktop Poet Screen Saver Settings
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Screen Saver (Continued)

•Wait - Sets the amount of time before the
screen saver starts.

•Configure - Opens the Windows Display
Properties control panel to the Screen Saver
tab.

From the Windows Screen Saver, click
Settings.

Figure 19 Desktop Poet Screen Saver Settings

Desktop Poet - User Guide for Windows 27 of 31



Chapter 6
Keyboard Controls

What’s In This
Chapter?

This chapter
details the
keyboard
controls in
Desktop Poet

How can I control Desktop Poet with keyboard commands?

•Space Blinks the current selection, just like selecting the Blink Selection menu item.

•Escape Shows the next word form on the selected tile or tiles.

•Tab Selects all tiles identical to the selected tiles, just like the Match Selection menu
item.

•Del deletes the currently selected tiles, just like the Delete menu item.

•Ctrl-a Selects all the tiles, just like the Select All menu item.

•Ctrl-x Cuts the currently selected tile(s), just like the Cut menu item.

•Ctrl-c Copies the currently selected tile(s), just like the Copy menu item.

•Ctrl-v Pastes the contents of the Windows clipboard, just like the Paste menu item.
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Chapter 7
Sharing & Enjoying

What’s In This
Chapter?

This chapter
shows you
how to share
your poems
with others

How can I share my poems with others?

Desktop Poet makes it easy to export your poems to formats that can be shared over
email or the web, here’s how:

1. Select the tiles the poem is composed of and then choose an export option.
Under the File menu, choose to export the selection to JPEG, Bitmap image or an
HTML page; these choices will save the exported poem to a file.

2. Copy the selected poem to the clipboard as text or as an image; these choices
will place the poem on the clipboard, but will not save a file to disk. Find Copy
and Copy Image in the Edit menu.

3. Display your poems in the Windows Screen Saver. Choose Export Selection to
Screen Saver, then in the Preferences, enable the screen saver. Voila!
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Chapter 8
License Agreement

What’s In This
Chapter?

License
Agreement

Fine Print
lawyer-type
stuff.

Good bedtime
reading.

LICENSE AGREEMENT
IMPORTANT - YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS OF THE LICENSE AGREEMENT TO
DETERMINE WHETHER YOU AGREE TO BE BOUND BY ITS PROVISIONS.

1. NOTICE.  WE ARE WILLING TO LICENSE THE ENCLOSED SOFTWARE TO YOU ONLY ON THE CONDITION THAT YOU ACCEPT
ALL OF THE TERMS CONTAINED IN THIS LICENSE AGREEMENT.  PLEASE READ THIS LICENSE AGREEMENT CAREFULLY BEFORE
OPENING THE SEALED DISK PACKAGE.  BY OPENING THIS PACKAGE YOU AGREE TO BE BOUND BY THE TERMS OF THIS
AGREEMENT.  IF YOU DO NOT AGREE TO THESE TERMS WE ARE UNWILLING TO LICENSE THE SOFTWARE TO YOU, AND YOU
SHOULD NOT OPEN THE DISK PACKAGE.  IN SUCH CASE, PROMPTLY RETURN THE UNOPENED DISK PACKAGE AND ALL OTHER
MATERIAL IN THIS PACKAGE ALONG WITH PROOF OF PAYMENT, TO THE AUTHORIZED DEALER FROM WHOM YOU OBTAINED
IT FOR A FULL REFUND OF THE PRICE YOU PAID.

2. Ownership and License.  This is a license agreement and NOT an agreement for sale.  We continue to own the copy of
the software contained in this package and all other copies that you are authorized by this Agreement to make (the
"Software").  Your rights to use the Software are specified in this Agreement, and we retain all rights not expressly
granted to you in this Agreement.  Nothing in this Agreement constitutes a waiver of our rights under U.S. Copyright law
or any other federal or state law.

3. Permitted Uses.  You are granted the following rights to the Software:

(a) Right to Install and Use.
  You may either:
  (i) install the Software on multiple computers, provided that those computers are used solely by you, but not
simultaneously; or
  (ii) install the Software on a single computer which may be used by different users from time to time but not
simultaneously.
If the Software is to be used by more than one user under option (i) above or on more than one computer under option (ii)
above, you must purchase a number of copies (or a multi-user package representing multiple copies) of the Software
equal to the number of users under option (i) or Computers under option (ii).
(b) Right to Copy. Ownership of the legal rights contained in the Software and the associated documentation shall remain
solely with Mariner  Software and its suppliers. These may include trade secret, trademark, copyright, patent,
international treaty and other rights as applicable.
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License
Agreement

Are you really
reading this
page?

You should be
using Desktop
Poet now.

You may not sublicense, rent, lease, decompile, disassemble, create derivative works or otherwise distribute the
Software.  You may make an archival copy of the Software. You may not copy the written materials accompanying the
Software.
(c) Right to Transfer. You may permanently transfer the complete Software and accompanying materials by delivering the
original Software media and materials to a third party who accepts the terms and conditions of this Agreement, and by
simultaneously destroying all copies of the Software and accompanying materials in your possession. Such a transfer
terminates your license to use the Software.

4. Export Control.  The Software may be subject to United States export control.  You agree to fully comply with all
applicable United States export regulations.

5. United States Government Restricted Rights.  The enclosed Software and documentation are provided with Restricted
Rights.  Use, duplication or disclosure by the U.S. Government or any agency or instrumentality thereof is subject to
restrictions as set forth in subdivision (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at 48 C. F.R.
252.227-7013, or in subdivision (c)(1) and (2) of the Commercial Computer Software — Restricted Rights Clause at 48
C.F.R. 52.227-19, as applicable.  Contractor Manufacturer is Mariner Software Inc., 401 N. 3rd Street, #665, Minneapolis,
MN 55401.

6. Limited Warranty.  Mariner Software warrants that the media on which the Software is recorded will be free of defects
in materials and workmanship under normal use for 90 days after the date of original purchase.  If a defect occurs during
the 90-day period, you may return the disk(s) to Mariner Software for free replacement. Mariner Software will replace
the disk(s) provided that you have previously returned the product registration card accompanying the Software to us.

7. WARRANTY DISCLAIMER. WE DO NOT WARRANT THAT THIS SOFTWARE WILL MEET YOUR REQUIREMENTS OR THAT ITS
OPERATION WILL BE UNINTERRUPTED OR ERROR-FREE.  WE EXCLUDE AND EXPRESSLY DISCLAIM ALL EXPRESS AND IMPLIED
WARRANTIES NOT STATED HEREIN, INCLUDING THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE.
Some states do not allow the exclusion of implied warranties, so the above exclusion may not apply to you.  This limited
warranty gives you specific legal rights, and you may also have other legal rights, which vary from state to state.

8. LIMITATION OF LIABILITY.  OUR LIABILITY TO YOU FOR ANY LOSSES SHALL BE LIMITED TO DIRECT DAMAGES, AND SHALL
NOT EXCEED THE AMOUNT YOU ORIGINALLY PAID FOR THE SOFTWARE.  IN NO EVENT WILL WE BE LIABLE TO YOU FOR ANY
INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES (INCLUDING LOSS OF PROFITS) EVEN IF WE HAVE BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
Some jurisdictions do not allow these limitations or exclusions, so they may not apply to you.

9. Miscellaneous Provisions. This Agreement is governed by the laws of the State of Minnesota. Should you have any
questions regarding this Agreement, or desire to contact Mariner Software Inc. for any reason, please write:  Mariner
Software Inc., 401 N. 3rd Street, #570, Minneapolis, MN 55401.
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